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Course Prerequisites

Word XP Legal – Module I, which contains instruction on the core tools you will
need in order to produce legal documents in Microsoft Word XP, should be
completed first.  This training module, Microsoft Word XP Legal – Module II,
assumes you are already familiar with the core tools and consists of the further
advanced document editing and handling tools you will need in order to create
complex legal documents.

Prior to using this training module, you should be able to do the following:

• Navigate Microsoft Word XP

• Manage documents

 Create, save, close and
open documents

 Spell and grammar check
documents

 Print documents
• Edit documents

 Select, correct and delete
text

 Use undo and redo
 Move and copy text
 Collect and paste text
 Reveal text formatting
 Work with document views
 Zoom documents
 Find and replace text

• Format text

 Change margin and page
size

 Change line spacing and
justification

 Change fonts
 Format paragraph tabs and

indents
 Add paragraph numbers

and bullets

 Use the format painter

• Use Help

• Insert dates and times

• Insert symbols and special
characters

• Use automated features

 Use AutoCorrect
 Use AutoFormat-As-You-

Type
 UseAutoText

• Work with styles

 Apply predefined styles
 Create, modify and delete

styles

• Use advanced find and replace

 Replace formatting and
special characters

• Work with headers and footers

 Insert page numbers
 Add, modify and remove

content in headers and
footers

• Understand section breaks

 Add and remove page and
text breaks

 Add and remove continuous
and next page section
breaks
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Introduction

This training program is designed to make your training experience comfortable
and uncomplicated, providing thorough descriptions and step-by-step instructions. 
You should have a basic understanding of word processing before you begin this
training program.  This program consists of two modules.  You are working in
Module II. 

Word XP Legal – Module I, which contains instruction on the core tools you will
need in order to produce legal documents in Microsoft Word XP, should be
completed first.  This training module, Microsoft Word XP Legal – Module II,
assumes you are already familiar with the core tools and consists of the further
advanced document editing and handling tools you will need in order to create
complex legal documents. 

This training module is divided into sections containing step-by-step lessons that
are followed by practice scenarios.  Where appropriate, multiple lessons are
combined into one practice scenario. Each section is concluded with a list of notes
and new shortcuts introduced. 

The step-by-step lessons are provided as a reference tool, and the practice
scenarios are provided to allow you to perform the steps in a realistic fashion in
the training environment.  This training module is concluded with comprehensive
exercises.  The exercises should be performed individually upon completion of
this training program to reinforce the tools learned.

To make this training program relative to your daily work, the practice scenarios
are based on both a litigation case and a transactional matter.  The practice
scenarios are “skits” based on three characters, an attorney, an associate and their
legal assistant/legal secretary, and follow workflow in a law office.  The practice
scenarios and exercise generally proceed in a realistic manner.  However, in order
to provide the most effective practice scenarios and exercises, some of them may
proceed differently than you might actually handle a similar matter in your office. 

Because many law firms are either migrating from WordPerfect to Word, or are
using both word processing programs, this training program contains references
to the differences and equivalencies of WordPerfect and Word. This information
is intended to give you a comprehensive understanding of how Word operates in
comparison to WordPerfect, helping your transition be as stress-free as possible.

Important Note

Because this training program was designed to simulate realistic document
production in law firms, using “save as” and document sharing tools (including
track changes, document compare and merge documents) are included.  You
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should be aware, however, that using these tools leaves “metadata” in documents. 
Metadata is, by simple definition, data about data.  More specifically, it is hidden
information about electronic documents that is automatically created and tracked. 
To avoid sending metadata to outside parties, it is highly recommended that all
documents that must be shared electronically be converted to pdf format
(pdf=portable document format and is read by Adobe Acrobat Reader) prior to
transmittal.  For those documents that are required to be shared in Word format, it
is recommended that all metadata be removed.  If such documents must include
tracked changes or document comparison, a third party tracking/comparison tool
should be used. 

Methods to remove individual segments of metadata may be found on Microsoft’s
web site.  However, there are several inexpensive metadata removal tools made
for use in law offices that remove all or selected segments of metadata at once. 
These tools can be easily located on the Internet through searches such as
“metadata removal” and “metadata scrubber.”

Further, there are third-party tracking tools that will use redline and strikeout to
display modifications in and comparisons of documents without leaving metadata. 
These tools may also be easily located on the Internet through searches such as
“redlining tools for word documents” and “blacklining software for word
documents.”
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Working with Templates

You will learn how to use and create Word templates in this section.  Templates
are a form of automated document creation, including simple forms, automatically
updated fields and text prompts, that aid in efficient document production. 

This section includes the following lessons:

• Using Template Documents

• Using Templates Provided by Word

• Creating Text Only Templates

• Creating Interactive Templates
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Creating Interactive Templates

Interactive templates contain prompts for data input.  In this lesson you will learn
to use Word’s interactive template tools for more advanced document
automation.

Lesson Objectives

• Create an interactive template

• Use an interactive template
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Notes
Steps

1. Click on the following menu sequence:  File → New.

The New Document task pane will appear as follows:

2. Click on the General Templates link in the New from
template section of the task pane. 

Note:  When
you are
creating a
template the
title bar will
indicate you
are working in
a template
rather than a
document.
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Notes
The Templates dialog box will appear as follows:

3. Click on the Template radio button.

4. Click on the OK command button ( ).

5. Type the desired text for your template.

6. Position your insertion point in the document where you
wish to place a prompt or updating field.

7. Click on the following menu sequence: Insert → Field.

The following Field dialog box will appear:
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Automatic Numbering

There are multiple methods for applying automatic numbering in Word
documents.  In this section you will work with all the methods and learn to
determine where each method is most appropriately applied.  The automatic
numbering tools in Word function very different than those in WordPerfect. 
Understanding these numbering tools is key for efficiently creating legal
documents in Word.

This section includes the following lessons:

• Single-level numbering

• Multi-level Numbering

• Numbering with Styles

• Numbering within Paragraphs

• Numbering with Formatted Text

• Numbering with Sequence Fields
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Multi-level Numbering

Use the outline numbering tool for lists with multiple levels.  You may use
Word’s predefined numbering formats, including the Legal Numbering format, or
customize them to meet your needs. 

Lesson Objectives

• Use Predefined Numbering formats

• Customize Multi-level numbering formats

• Share Customized Automatic Numbering
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Notes
20. Click on the Continue previous list radio button and

click on the OK command button ( ).

21. Type the following: New Business and press the Enter
key.

22. Click on the Increase Indent button ( ) to change the
4) to a).

23. Type the following: New Receptionist and press the
Enter key.

24. Type the following: CLE Policy and press the Enter
key.

25. Press the tab key to demote the c) to i).

26. Type the following: Partners and press the Enter key.

27. Type the following: Associates and press the Enter
key.

28. Click on the Decrease Indent ( ) button two times to
change the iii) to 4).

29. Type the following: Billing Requirements for
Interns and press the Enter key.

30. Press the Backspace key to discontinue automatic
numbering.

31. Save the document as cbDtlAgn.doc in the C&B folder
using your favorite file save method.

32. Keep the cbDtlAgn.doc file open for use in the next
practice scenario.

Customizing Multi-level Numbering

Steps

1. Click on the following menu sequence: Format →
Bullets & Numbering.

The Bullets and Numbering dialog box will appear.

2. If necessary, click on the Outline Numbered tab.
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Notes
The Bullets and Numbering dialog box will appear as
follows:

3. Click to select the numbering format that most closely
resembles your desired numbering format.

4. Click on the Customize command button ( ).

The following Customize Outline Numbered List dialog
box will appear:

5. Click on the More command button ( ) to
expand the available options.
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Notes
The expanded Customize Outline Numbered List dialog box
will appear as follows:

The following table describes the Custom Numbering options:

Item Description

Level Click on the level of the outline you wish
to modify

Number format Type additional text to go with a number,
e.g., parenthesis (), or periods .

Number style Select the desired number type; the
Preview window will reflect the current
selections

Start at Change the starting value

Previous level number Include a number from the previous level
(e.g. A3); this will include the number
from the previous level but not any text
from the previous level

Font Open the font dialog box to change the
font of the numbering scheme, not the
text after the numbers

Number position Select alignment of the number

Aligned at Select the spacing position to align the
numbers at

Note:  To
designate the
paragraph text
to begin with
underlined
characters and
the paragraph
number to
contain no
underline, click
on the Font
button
( ) in the
Customize
Outline
Numbered List
dialog box,
click on the
Underline
drop-down
arrow and
select None.
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Generating Cross-References, Tables of Contents
and Authorities

Generating automatic references in Word includes cross-references, tables of
contents and tables of authorities.  These automatic referencing tools in Word are
accomplished using fields.  (Fields were introduced in the Templates and
Automatic Numbering sections of this training program).  These fields are
automatically inserted when you use Word’s reference tools and can be updated
as your document changes.

This section includes the following lessons:

• Creating Cross-References

• Creating a Standard Table of Contents

• Creating Custom Table of Contents

• Updating Table of Contents

• Creating Table of Authorities
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Creating Standard Tables of Contents

A standard table of contents can be easily created in Word based on Word’s
built-in heading styles.  In other words, if you use the Heading 1 through Heading
9 styles in your document, the table of contents will be generated based on the
text the headings are applied to.  Unlike WordPerfect, there is no “marking”
necessary when using these styles to create tables of contents. 

Lesson Objectives

• Create a table of contents based on heading styles
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Notes
Steps

1. Create your document using Word’s built-in Heading 1
through Heading 9 styles.

2. Position your insertion point where you wish to generate
the table of contents.

3. Click on the following menu sequence: Insert →
Reference → Index and Tables.

The Index and Tables dialog box will appear.

4. Click on the Table of Contents tab.

The Index and Tables dialog box will appear as follows:

The following table describes the Index and Tables dialog box
options.

Item Description

Show page numbers Select to display the corresponding
page numbers on the table of
contents

Right align page numbers Select to right-align page numbers

Tab Leader Select desired tab leader to appear
between table of contents entry and
corresponding page number

Note: You will
need to type
the Table of
Contents title
as it is not
automatically
created.

Note:
Remember to
insert a Next
Page Section
break so the
document text
will be in a
different
section than
the Table of
Contents. If
necessary, in
the Table of
Contents
section change
your page
numbering
options to i, ii,
iii; in the
document
section change
your page
numbering
options to 1, 2,
3 and start
numbering at
1.
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Notes
Item Description

Formats Select table of contents style

Show levels Select the number of heading levels
to appear in the table of contents

Display the outline toolbar

Select styles associated with table of
contents level

Modify the style associated with the
table of contents levels

5. Make the desired selections using the options described
above.

6. Click on the OK command button ( ).

Practice Scenario

Robbie Rainmaker:  I need a table of contents for the White
Shareholder's Agreement and I also need one for the Tayler
Shareholder's Agreement but the Tayler one I want to
look…you know…a little different…see what you can come up
with.

Sally Slick:  Okay, I'll do one and let you see it.

Sally Slick:  °°°Different - now that is a term I'm sure he
learned in law school.

1. Open the whiShrAg.doc file from the White folder using
your favorite file open method.

2. Click on the following menu sequence: Insert → Break.

3. Click on the Next page section break radio button and
click on the OK command button ( ).

4. Press the Ctrl-Home shortcut key combination to go to the
beginning of the document in Section 1.

Note:  Your
Table of
Contents will
appear as a
field that can
be updated by
pressing the
F9 shortcut
key. 

Note: If you
need to
manually edit a
table of
contents, hold
down the Ctrl
key and click in
the entry and
you will be in
the table of
contents entry
to edit;
however, if you
update the field
it will revert
back.
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Entering Table Data

Entering and editing data in Word tables is a simple process.  There are many
available shortcuts to help you quickly navigate tables.

Lesson Objectives

• Navigate tables

• Enter data into tables
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Notes
Navigating within a Table

The following table describes the methods of table navigation:

Keystrokes Action

Tab Move to next cell; add
additional row if pressed from
the last table cell

Shift-tab Move to previous cell

↑ Move to the preceding row

↓ Move to next row

Alt-Home Move to first cell in current
row

Alt-End Move to last cell in current
row

Alt-Page Up Move to first cell in current
column (row 1)

Alt-Page Down Move to last cell in current
column (last table row)

Hover mouse pointer over top border of
column until it changes to a heavy down
arrow ( ) and click once

Select entire column

Hover mouse pointer at the left border
of a row until it changes direction to the

right ( ) and click once

Select entire row

Hover mouse pointer over upper left-
hand corner of table until it changes to
the four-sided arrow ( ) and click

Select entire table; apply
formatting or move entire
table

Hover mouse pointer over lower right-
hand corner of table until it changes to
resize handle ( ), click and drag

Resize entire table
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Notes
Keystrokes Action

Hover mouse pointer over any column
or row border until it changes to a two-
sided arrow ( , ), click and drag

Resize row height or column
width

Entering Data into Table Cells

1. Position your insertion point in the cell where you wish to
insert data.

2. Type information in cell. 

Practice Scenario

Doris Daylight:  This delivery is for you.

Sally Slick:  Thanks.

Sally Slick:  °°°I need to prepare an Expense Reimbursement
Invoice for Joe.

1. Open the cbExReim.doc file from the C&B folder.

2. Save the document as greExp.doc in the Green folder
using your favorite file save as* method.

3. Press the Ctrl-End shortcut key combination to position
your insertion point at the end of the document.

4. Click on the Insert Table button ( ) on the standard
toolbar to expand the table-create grid.

5. Drag down 2 blocks and drag right 4 blocks, then release
the mouse to create a 2 x 4 table.

Note: The table grid will contain 2 rows and 4 blocks as
shown below.

* See important note regarding metadata on page 1.

Note: When
you are
working in a
table, there is
no need to
press the
Enter key at
the end of a
line, unless
you want the
line to break
(hard return).
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Using Mail Merge

Word’s Mail Merge tool is the equivalent of WordPerfect’s merge tool.  It is
used to automate the process of creating form letters, mailing labels, envelopes
and catalogs.  Mail merge consists of creating the main document – the form
letter, envelope or label format – and merging it with the data source – the unique
information, such as names and addresses, that will be deposited into designated
places in the main document.

Lesson Objectives

• Create form letters and data sources

• Create mailing labels

• Create envelopes
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Notes
Using Mail Merge to Create Form Letters

Steps

1. Click on the following menu sequence: Tools → Letters
& Mailings → Mail Merge Wizard.

The Mail Merge task pane will appear as follows: 

2. Click on the Letters radio button in the task pane.

3. Click on the Next: Starting document link at the
bottom of the task pane.
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Notes
The Mail Merge task pane will appear as follows: 

4. Do one of the following to select the form’s main
document:

Click on the Use the current document radio
button to use the document in the current window as the
form’s main document;

Click on the Start from a template radio button to
use a Word template as the form’s main document, then
click on the Select template link to select the
template; or

Click on the Start from existing document radio
button to use an existing document as the form’s main
document, then click on the Open ( ) command
button to locate the document.

5. Click on the Next: Select recipients link at the bottom
of the task pane. 
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Notes
The Mail Merge task pane will appear as follows:

6. Do one of the following to select the recipients:

Click on the Use an existing list radio button; then
click on the Browse link to locate the list file and
proceed to step 7;

Click on the Select from Outlook contacts radio
button; then click on the Choose Contacts Folder
link to select the appropriate contact folder and proceed
to step 7; or

Click on the Type a new list radio button; then click
on the Create link to use the New Address List dialog
box and follow the substeps below.
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Notes

a. Customize the form to contain the fields you wish
to use by clicking on the Customize command
button ( ).

The following Customize Address List dialog box
will appear:

b. Remove fields you do not wish to use by clicking
on the field name in the Field Names list and
clicking on the Delete command button
( ).

c. Type additional field names you wish to use by
clicking on the Add command button ( )
and typing the field name as prompted.

d. Change the order of the field names by selecting the
field name you wish to move in the Field Names
list and clicking on the Move Up ( ) or
Move Down ( ) command buttons.

Note: The
most
commonly
used field
names are
displayed in
the New
Address List
dialog box.
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Converting WordPerfect Documents

The need to convert documents from WordPerfect to Word is common in law
firms.   It is important to note that conversions can cause several problems in your
Word documents, including terrible formatting problems and document
corruption.  Therefore, it is crucial to use the methods described herein rather than
using the built-in conversion filters.

Lesson Objectives

• Convert documents if you have WordPerfect installed on your
computer

• Convert documents if you do not have WordPerfect installed on your
computer
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